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Executive Summary

The Florida Department of Transportation (FDOT) currently monitors about 7,000 traffic count
sites including over 300 permanent telemetered traffic monitoring sites (TTMSs). The
monitoring equipment generally consists of traffic-actuated sensing devices imbedded in the
pavement and classification equipment that captures the traffic volumes, vehicle classifications,
and truck weights. The information captured by the field monitoring devices is thereafter
downloaded and processed to get information on annual average daily traffic (AADT), K-factor,
T-factor, truck weight, and other pertinent information. This information is used in various
forms by different FDOT departments for planning, designing, operations, and maintenance
activities relating to both highway pavements and bridges.

The FAMU-FSU College of Engineering (COE) was contracted to provide electrical engineering
support to the Transportation Statistics Office of the FDOT in improving the accuracy and
reliability of the TTMS sensors and communication equipment. The principal investigator for
the project was Dr. Bruce A. Harvey of the Department of Electrical and Computer Engineering.
The project was conducted from December 10, 2008 to March 30, 2010. The following major
efforts conducted under this project:

1. Lightning Surge Suppression Field Tests

2. Segmented Sensor Interface Electronics Improvements

3. Sensys System Support for Short-Term Traffic Count Applications

4. Monitoring Loop Ground Resistance and Piezoelectric Sensor Outputs

Lightning Surge Suppression Field Tests

Lightning surge current count and measurement field tests were continued in this project with the
goal of characterizing the lightning surges experienced by in-pavement sensors at TTMSs. The
data collected demonstrates the need for surge suppressors to protect the count and classification
equipment at the sites. These suppressors need to be able to protect the equipment from
lightning surges of at least 3,000 amps and to endure thousands of surges.

Segmented Sensor Interface Electronics Improvements

Previous research demonstrated that a segmented sensor can improve the accuracy of vehicle
classification. Also demonstrated was the feasibility of using a more durable extruded polymer
segmented sensor. In this effort, electrical characterization of the extruded sensor was begun
with the goal of developing an electronic interface capable of more accurately detecting segment
closures. This effort was reduced at the request of the FDOT in order to apply more resources to
other efforts in this project. Funding from the Federal Highway Administration (FHWA) is
being sought to continue this research and development.



Sensys System for Support for Short-Term Traffic Count Applications

The Sensys wireless traffic count system was investigated and tested to determine if and how this
system can be used for temporary traffic count applications. The concept included installing
permanent wireless detectors in the count site and using a mobile Sensy access point to collect
the count data. This effort resulted in the identification of the appropriate access point (AP240S)
and the appropriate procedures for using the Sensys system for temporary traffic count
applications. An instruction manual was compiled and is included in Appendix A.

Monitoring Loop Ground Resistance and Piezoelectric Sensor Outputs

This research team in cooperation with a research team led by Dr. Ren Moses monitored the
electrical characteristics (inductance, ground resistance and voltage output) of in-pavement
sensors at Sites 112 and 352 over a period of about 6 months. The goal of the effort was to
monitor the effects of sensor sealant degradation on the electrical performance of the sensors.
This ongoing effort is helping the FDOT identify appropriate sealants to use for in-pavement
sensor installation, and to help the FDOT develop effective maintenance procedures to prolong
the useful life of in-pavement sensors.

Benefits to the FDOT
All of the efforts under this project are helping the FDOT improve accuracy and reliability of

traffic data collection, reduce maintenance cost of TTMS installations, and identify new
technologies to aid in the collection of traffic data statistics.
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1. Introduction

The Florida Department of Transportation (FDOT) currently monitors about 7,000 traffic count
sites including over 300 permanent telemetered traffic monitoring sites (TTMSs). The
monitoring equipment generally consists of traffic-actuated sensing devices imbedded in the
pavement and classification equipment that captures the traffic volumes, vehicle classifications,
and truck weights. The information captured by the field monitoring devices is thereafter
downloaded and processed to get information on Annual Average Daily Traffic (AADT), K-
factor, T-factor, truck weight, and other pertinent information. This information is used in
various forms by different FDOT departments for planning, designing, operations, and
maintenance activities relating to both highway pavements and bridges.

The Department of Electrical and Computer Engineering at the FAMU-FSU College of
Engineering (COE) was contracted to provide support to the Transportation Statistics Office
(TSO) of the FDOT in improving the accuracy and reliability of the TTMS sensors and
communication equipment. The major efforts conducted under this project were

1. Lightning Surge Suppression Field Tests,

2. Segmented Sensor Interface Electronics Improvements,

3. Sensys System Support for Short-Term Traffic Count Applications, and
4. Monitoring Loop Ground Resistance and Piezoelectric Sensor Outputs.

In addition to the major efforts, the COE also provided technical support for the TSO as needed
throughout the project.



2. Lightning Surge Suppression Field Tests

Protection of the over 300 permanent TTMS installations from the damaging effects of lightning
is of critical importance to the FDOT. Sites damaged by lightning result in the reduction of
statistical information collected on the number and classification of vehicles operating on
Florida’s highways. Also, the cost of repairing the sites damaged by lightning is considerable.
Florida is known as the lightning capital of North America and thus much of the state
(particularly central Florida) is subject to more lightning than the rest of the United States.

To address the problem of lightning protection for TTMSs this research project continued the
efforts of a previous research projects (Project No. BC-596, “Improving Operation of FDOT
Telemetered Traffic Monitoring Sites” and Project No. BD-543-3, “Electrical Engineering
Support for Telemetered Traffic Monitoring Systems”). In this task, more sensors and loggers
were acquired to expand the testing to a greater number of sites and sensors. More interface
circuits were also constructed to accommodate the number of sensors (current transformers).
Each of the sensors, loggers and interface circuits will be tested and calibrated in the laboratory
using the MIG0606 surge generator. Each of the sensors and interface circuits will be calibrated
to measure surges of 70 amps to 4,000 amps; a range that has worked well in past field tests.
During the peak lightning season in the summer of 2009, these lightning current measurement
systems were installed in TTMSs along the I-4 corridor.

Activities Conducted

Discussions were held with Rick Reel and Kip Jones to determine the extent of the
measurements to be conducted. In the previous project (BD-543-3) 2 surge current measurement
systems were assembled consisting of a Campbell Scientific CR-800 data logger, 2 Model 101
Pearson Electronics current sensors and 2 custom sensor interface boxes. This allowed the
detection and measurement of the lightning surge currents on 2 sensor leads in each of 2 TTMS
locations over the summer of 2008. The data collected in 2008 indicated that the surge currents
may differ depending on whether the currents are measured on the active lead of the
piezoelectric sensors or the ground leads. More measurements were needed to determine the
validity of the difference.

Discussions with the FDOT concluded that an additional 3-sensor current measurement system
was to be added to the two existing 2-sensor measurement systems. This will enable the
collection of date from an additional TTMS location and the comparison of surge currents on the
active and ground leads of a piezoelectric sensor. Therefore, 3 Model 101 Pearson Electronics
current sensors and an additional Campbell Scientific CR-800 data logger were acquired. The
sensor interface boxes used in 2008 had been modified several times so it was decided to build
seven new sensor interface boxes for the 4 existing sensors and the 3 new sensors. All the surge
current measurement systems were completed, calibrated and programmed.

The sites chosen for installation of the surge current measurement systems were TTMS Sites
0086 and 0162 near Tampa, and Site 0060 on US98 in Franklin County. The sites near Tampa
each had a 2-sensor surge current measurement system installed, and the 3-input system was
installed in Site 0060.



The schedule of lightning surge suppression field tests conducted in 2009 was as follows:

TTMS Site 0060

June 11, 2009: Current measurement system with 3 current sensors installed. One current
sensor was connected to monitor the surge current on Loop 4. Two current sensors were
connected to monitor the currents on the active and ground leads of Piezo WB.

July 14, 2009: Data downloaded from the CR800 logger. No surges recorded. The op-
amps were replaced (previous experience indicates these are the most vulnerable to
failure). Removed the batteries for charging.

July 15, 2009: Charged batteries placed back in the cabinet and logger restarted.

August 19, 2009: Data downloaded from the logger. Only 2 surges recorded. All
equipment removed for testing. No problems found when equipment tested in the lab.
September 4, 2009: Current measurement system reinstalled at the site.  Same
configuration used as was used in June.

October 16, 2009: Data downloaded from the logger. All equipment was removed from
the site and the field test was ended. Total number of days monitored at Site 0060 was
110 days.

TTMS Site 0086

June 14, 2009: Current measurement system with 2 current sensors installed. One current
sensor was connected to monitor the surge current on Loop 8 and the other monitoring
the ground lead on Piezo 4.

July 20, 2009: Downloaded data from the CR 800 logger and removed batteries for
charging. On Loop 8 there were 9 periods of lightning surge activities. On Piezo 4 there
were 6 periods of lightning surge.

July 21, 2009: Charged batteries placed back in the cabinet and logger restarted.

August 17, 2009: Downloaded the data from the logger and the batteries were replaced.
On Loop 8 there were 8 periods of lightning surge activities since July 21st. On Piezo 4
there were also 8 periods of lightning surge since July 21st.

October 19, 2009: Data downloaded from the logger. All equipment was removed from
the site and the field test was ended. Total number of days monitored at Site 0086 was
126 days.

TTMS Site 0162

June 14, 2009: Current measurement system with 2 current sensors installed. One current
sensor was connected to monitor the surge current on Loop 4 Red and the other
monitoring the active lead on Piezo 4 Black.

July 20, 2009: Downloaded data from the CR 800 logger and removed batteries for
charging. On Loop 4 Red there were 6 periods of lightning surge activities recorded. On
Piezo 4 Black there were 5 periods of lightning surge activity.

July 21, 2009: Charged batteries placed back in the cabinet and logger restarted.

August 17, 2009: Downloaded the data from the logger and the batteries were replaced.
On Loop 4 Red there were 7 periods of lightning surge activities recorded since July 21st.
On Piezo 4 Black there were also 7 periods of lightning surge activity since July 21st.



e October 19, 2009: Data downloaded from the logger. All equipment was removed from
the site and the field test was ended. Total number of days monitored at Site 0162 was
126 days.

Results of Lightning Surge Suppression Field Tests

A summary of the lightning surges recorded during the field test in 2009 are tabulated in
Figure 2.1.

?éfjeajs) Sensor # Surges | Max. Surge Current | Ave. Surge Current
0060 Loop 4 15 546 A 219 A
(110) Piezo WB — Ground Lead 24 471 A 176 A
Piezo WB — Active Lead 27 466 A 167 A
0086 Loop 8 464 1007 A 253 A
(126) Piezo 4 — Ground Lead 221 886 A 190 A
0162 Loop 4 Red 357 679 A 113 A
(126) | Piezo 4 Black — Active Lead 443 845 A 116 A

Figure 2.1: Summary of Lightning Surges Recorded in 2009

One of the primary objectives for the data collection at Site 0060 was to determine if the number
and magnitude of lightning surges differed between the active and ground leads of a piezoelectric
sensor. For this test there was little difference between the active and the ground leads of Piezo
WB at Site 0060. Figure 2.2 shows the recorded surges and demonstrates the similarity of the
surges recorded on the active and ground leads of the piezo sensor. The only difference was 2
small surges recorded on the active lead on August 15 and September 15, 2009.

There were relatively few surges recorded at Site 0060 (in comparison with site 0086 and
00162). Site 0060 recorded approximately 1 surge every 4 days on each of the sensors
monitored. Sites 0086 and 0162 had between 1.75 and 3.7 surges per day recorded on the
sensors monitored. While the data at site 0060 showed little difference between the surges
recorded on the active and ground leads of a piezo sensor, the amount of data collected was small
and hence the data is not thoroughly conclusive. Further testing is needed.

The total number and magnitude of surges per sensor recorded during 2009 were both lower than
were recorded in 2008. In 2008, 3 loops were monitored for a total of 380 days recording an
average of 7.77 surges per day, and 1 piezo sensor was monitored for 127 days recording an
average of 32.7 surges per day. The peak surge recorded in 2008 was 2,679 amps. In 2009, 3
loops were monitored for a total of 362 days recording an average of 2.31 surges per day, and 3
piezo sensors were also monitored for a total of 362 days recording an average of 1.90 surges per
day. The peak surge recorded in 2009 was 1007 amps.
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Although the lightning surges were lower in 2009 than in 2008, the results were fairly consistent.
Peak surges were in the low 1,000s of amps and multiple surges per day were averaged. The
Lightning surge current measurement system developed and used in these tests is providing
significant insight into the number and magnitude of lightning surges experienced by the TTMS
in-pavement sensors. These results will help the FDOT choose the appropriate surge suppressors
to protect the TTMS equipment from lightning damage. The result will be lower maintenance
costs and higher reliability data collection. It is recommended that testing continue to improve
the quality, quantity and variety of the data collected to more accurately quantify the lightning
surge environment for the TTMS sensors.



3. Segmented Sensor Interface Electronics Improvements

The Florida Department of Transportation currently maintains over 300 telemetered traffic
monitoring sites (TTMSs) throughout the state to monitors traffic operations on the state
highway system. Most of these TTMSs employ inductive loop detectors and piezoelectric axle
sensors to determine the number of axles, axle spacing and length of individual vehicles. This
information is used to attempt to determine the classification of the wvehicles. Vehicle
classification statistics are used to estimate pavement wear and traffic patterns, and to plan
maintenance and improvements of the roads. Thus accurate classification of vehicles is critical
to the FDOT.

Classification of vehicles using number of axles, axle spacing and length alone can result in a
significant number of classification errors. For example, a long-bed pickup truck with all single
tires (Class 3) can easily have the length and axle spacing of some smaller trucks with 2 axles
and 6 tires (Class 5). Class 5 vehicles are generally heavier and carry larger loads than a Class3
pickup truck. Such misclassifications lead to inaccurate pavement loading statistics.

Classification algorithms can be improved if the axle sensor had the ability to detect single
versus dual tires on each axle. This information would greatly reduce misclassifications of
vehicles such as the Class 3 —Class 5 errors. John Reed of PET Corporation proposed a design
for a segmented axle sensor that can provide an estimate of the tire width and thus discriminate
between single and dual tire axles. This effort was designed to determine if the segmented axle
sensor is feasible and if the identification of single and dual tire axles can improve vehicle
classification accuracy.

Background

This effort is a continuation of efforts conducted under a previous research project (FDOT
Project BD-543-3). Initial design of the electronics interface for a segmented axle sensor were
conducted and field tests were performed to demonstrate the feasibility of using segmented axle
sensors to improve vehicle classification and to test the performance of the sensors and interface
electronics.

The effort was conducted in two phases. First, PET Corporation produced a prototype sensor
using metallic conductors. The segment lengths were designed with the aid of a study of tire
footprints conducted on a separate research project by Dr. Ren Moses. An electronics interface
was designed and constructed to sense the segment closures and transmit the closure information
via a serial port to a classification algorithm running on a laptop computer. Field tests were
conducted to demonstrate the operation of the sensor and interface, and to demonstrate the
improved classification accuracy using the tire width information.

The metallic sensor was implemented to provide a proof of concept before proceeding to the
second phase of the project. In the second phase of the project PET Corporation constructed a
prototype of a segmented sensor made entirely of conductive and non-conductive extruded
polymers. The extruded polymers are expected to be much more durable than the metallic



conductors and eventual automatic extrusion of a sensor is far more cost-effective and flexible
than the manual construction required for the metallic sensors.

A new electronics interface was designed and constructed for use with the extruded sensors. The
extruded polymer conductors used in the new prototype have a very high resistance that
complicates the interface design. The design team modified a design originated by Dr. David
Bourner of the University of Maryland. Several modifications were made to Dr. Bourner’s
design to improve the speed and accuracy of the electronics interface. The extruded sensors and
interface electronics were field tested along with the classification algorithm to demonstrate the
feasibility and benefits of the extruded sensor.

The implementation of the electronics interface and the field testing of the prototype metallic
segmented sensor demonstrated that tire width estimation resulting in single versus dual tire
discrimination can significantly improve the vehicle classification accuracy. The
implementation of an interface for and testing of the prototype extruded segmented sensor
demonstrated the feasibility of the design and interfacing of an extruded segmented sensor.
However, the field test also demonstrated the limitations of the existing design. The electronics
interface used with the extruded sensor had a limited frequency response and could not always
properly identify the closed segments.

Activities Conducted

The goal of this effort was to re-design the interface electronics for the extruded segmented
sensor. The previous approach was to detect closures by measuring the direct (DC) current
through each input/output pair. This approach was slow due to the high resistance and
capacitance of the sensor itself. Also, the approach also could not differentiate between certain
patterns of closures. To overcome these shortcomings, the research team will investigate new
designs using a continuous signaling approach that uses frequency diversity, code diversity
and/or time-of-arrival techniques. These techniques can improve the speed at which a closure is
detected, and have the potential to improve discrimination between certain patterns of closures
that led the previous interface electronics to report false (shadow) closures.

A 16-segment axle sensor made of extruded polymers was received from PET Corporation. The
sensor was tested to determine the bandwidth of the sensor that could be used for a frequency
diversity detection scheme. It was found that due to the resistance and capacitance inherent in
the sensor the frequency of test signals transmitted through the sensor needed to be no higher
than about 2 kHz in order to differentiate between open and closed segments. Therefore the
initial plan is to build a 4-input system where sinusoids are transmitted at different frequencies to
each of the sensor’s quartets of segments. The return signals on the 4 individual segment lines
will be filtered to identify the frequency of the returned signal. The combination of return line
and frequency will uniquely determine the location of a single closed segment on the sensor.

The multi-frequency method for detecting segment closures in the extruded sensor was found to
be very limiting and complex to implement. Capacitive links between conductors in the sensor
severely complicated the accurate detection of closed segments. Also, discussions for future
applications indicated that sensors with significantly more segments are desirable for some



applications.  Other techniques including pulse size variations and time-of-arrival pulse
techniques were also briefly investigated through laboratory testing with mixed results. It was
determined that a more accurate model of the sensor was needed in order to accelerate the design
process through simulation.

The modeling of the extruded sensor was begun by measuring resistance of the various
conductors internal to the sensor. This was facilitated by John Reed who supplied an
unassembled extruded sensor on which measurement could be made. The following resistances
were determined as the nominal resistances internal to the sensor:

Resistance of Extruded Conductor: Rc = 25 kQ per 6” segment
Resistance of Conductor and Contact: Ree = 3.4 kQ) per 6” segment
Resistance of Conductors to Connector: Re = 3 kQ each connector

Using these empirical values for resistance a DC or resistive model of the sensor was developed.
This model is depicted in Figure 3.1. Note that some of the resistors in the circuit of Figure 3.1
are combinations of measured resistors. For example, Rss = 4.7 kQ = Rg + 0.5 * Rec.

The DC model was simulated using several different DC stimulating (applying voltages or
currents) and sensing approaches to see if all combinations of closures can be accurately detected
based solely on the DC voltages and currents. Figure 3.2 shows an example of one of the
stimulating and sensing approaches attempted. It was found that in all approaches tried there
were still patterns of segment closures that could not be accurately detected; even patterns that
would be common during use in the roadway. Single segment closures and multiple closures
within a segment group (quartet) can be accurately detected. However, none of the techniques
analyzed can provide highly reliable closure detections when closures occur on more than one
segment group at the same time.

At the request of Rick Reel the efforts under this task were stopped at this point in the research.
Rick Reel, John Reed from PET Corporation and Dr. Harvey were working on getting the effort
funded through an Federal Highway Administration (FHWA) grant. An FHWA grant would
provide greater resources to complete the research and development of interface electronics for
the extruded segmented sensor. The project resources were applied to other efforts in the
project.
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4. Sensys System Support for Short-Term Traffic Count Applications

The FDOT tasked the project team to determine if a Sensys wireless detection system can be
used to efficiently conduct short-term traffic counts. In particular, the project team was to
identify easy methods to program the Sensys counters and to retrieve the data from the counters.
The concept was to install in-ground sensors at each of the sites used regularly for short-term
traffic counts. A single access point (AP) can then be moved from site to site to record the data
from the traffic sensors. The challenge is to identify the procedures needed to set up the access
point for each site, and then determine how to store the set-up for the next time the access point
is returned to the particular site. The Sensys access point was designed for permanent placement
with access to a network connection to collect the traffic data at a central site. The Sensys access
points do have some capability for local data collection and thus have the potential to be used in
a temporary count site without access to a network connection.

The FDOT had a Sensys access point and in-ground sensors installed at site 3041 (in
Tallahassee). The project team set up a portable computer to communicate with the access point
and installed the access point management software, TrafficDOT, on the computer. A study of
the Sensys manuals determined and a teleconference with Brian Fuller, Sensys technical support,
confirmed that a Sensys access point can backup it’s configuration to named filed on the
computer. This process is an efficient way to restore the configurations for each temporary
traffic count site for future use.

The access point installed at site 3041 was determined to be the model AP240U access point
which is used to activate contact closures for external traffic count equipment, but not capable of
storing traffic count statistics. Statistics can only be collected in an AP240 with the S (statistics)
option. Brian Fuller was contacted and he was able to send a license that upgrades the AP240U
to a AP240US access point which can collect binned traffic counts using the APSTAT function.

The upgraded access point has been tested to verify that it can indeed collect binned traffic
counts that can easily be downloaded using an FTP connection through a standard web browser
(Internet Explorer, Firefox ...). The backup and restore functions have been tested and verified
to enable a use to change the APs configuration (e.g. to move the access point to another site)
and then to be able to restore the configuration to the previous state.

An instruction manual was compiled to assist the FDOT personnel in setting up and using a
Sensys wireless detection system for temporary count and classification sites. This manual
includes instructions for performing the initial set-up of an access point at a count site, backing
up and restoring configurations for moving the access point between temporary sites, and other
necessary instructions such as setting time and downloading data. The instruction manual is
provided in Appendix A.
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5. Monitoring Loop Ground Resistance and Piezoelectric Sensor Outputs

Obtaining reliable data from the piezoelectric sensors and inductive loop sensors used in the over
300 TTMSs maintained throughout the state of Florida is of major concern to the FDOT
Transportation Statistics Office. Maintaining these in-pavement sensors is a continual task for
the FDOT. The wear from the traffic eventually begins to compromise the sealants used in the
installation of the sensors. As the sealants break down the ground resistance of the loops may
drop and the output voltage of the piezo sensors may be reduced. This reduces the reliability of
the sensors and the accuracy of the traffic count/classification equipment. The goals of this effort
include identifying the most efficient maintenance procedures to extend the useful life of in-
pavement sensors, and to identify the more reliable sealants and grouts to use during installation
of the sensors.

The objective of this task was to perform a field performance evaluation of the sealants and
grouts used for piezoelectric axle sensor and inductive loop sensor installations. The two sites
picked for field evaluation of sealants and grouts were Site 352 on Interstate 10 (I-10), and Site
112 on Interstate 75 (I-75). This evaluation was conducted in cooperation with the research team
led by Dr. Ren Moses of the Civil and Environmental Engineering Department (BDK83, TWO
#977-04) Dr. Moses’ team provided periodic observation of the rate of deterioration by taking
photographs and videos of how the bonding materials appeared over time. The research team for
this project performed electrical readings including the inductance and ground resistance of the
loop sensors, and voltage outputs of the piezoelectric axle sensors. The measurements and
observations were taken during both dry and wet weather conditions to determine whether there
was any moisture effect on the readings.

The information and evaluations were conducted over a period of time to evaluate the
deterioration of the sealants and grouts over time. Site 352 has 5 loop sensors and 4 piezo
sensors installed using a variety of sealants and grouts. This site is not an active site for
collecting traffic statistics, but rather a test site allowing the evaluation of the performance of
sensor sealants. Site 112 is an active count/classification site where some problems with existing
sealants were detected prior to the start of this effort. Some of the sensors were replaced while
others were re-sealed in order to evaluate the differences in degradation for new sensor
installations versus repairing sealants in sensors.

51 Experimental Setup

In order to get the information of interest, the following pieces of equipment were used:
» Ground Resistance and Inductance
0 Multimeters (Ohmmeter and Inductance Meter)
o Screwdrivers
> Voltage output
0 Test Vehicle: Chrysler Town and Country
o Datalogger: National Instrument USB-6009 Multifunction 1/0

12



0 Labview Express Software
0 Laptop Computer
0 Wire Probes

Recording Voltage Outputs from Piezoelectric Axle Sensors

The datalogger for measuring the piezoelectric sensor voltage output at Site 352 was the National
Instrument (NI) USB-6009 Multifunction 1/0 (shown in Figure 5.1). The NI datalogger has four
differential voltage outputs each measuring the result from one of the four piezo sensors. Each
differential out has a positive and negative terminal. All the four negative terminals (CH1-, CH2-
, CH3- and CH4-) from the datalogger are grounded to the earth ground attached to the
equipment cabinet at site 352 on interstate 10 (I-10). The four positive terminals (CH1+, CH2+,
CH3+ and CH4+) of the datalogger are connected to the positive signal connections on the
piezoelectric sensors 1-4 respectively. For proper triggering, the first sensor a vehicle on the
highway will encounter is connected to CH1. The datalogger is then connected to the laptop via a
USB cable.

Figure 5.1: National Instrument USB-6009 Multifunction 1/0 and Attached Probes

After the laptop computer is turned on, the LabView software is launched and a new project is
created with all the necessary parameters set. As the reference vehicle approaches the first piezo
sensor the run, and then record tabs are clicked to initiate the recording of events as the vehicle
goes over the sensors. The voltage outputs are time stamped and logged in a file which is then
exported to MS Excel for further data analysis and processing. The process is repeated for as
many different vehicles as are desired. A sample of the processed outputs is shown in Figure 5.2
representing the voltage outputs for the test vehicle, a Chrysler Town and Country Minivan.
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Figure 5.2: Example Piezo Sensor Voltage Outputs using the Test Vehicle

Ground Resistance and Inductance Measurements

A handheld multimeter was the main piece of equipment used to measure the inductance and
ground resistance of the loop sensors at Site 352 on 1-10 and Site 112 on I-75. Site 352 has five
loop sensors labeled L1, L2, L3, L5 and L6 as shown in the site layout in Figure 5.3. Site 112 has
twelve loop sensors (the Northbound and Southbound lanes have six loops each) labeled L1 to
L12 as shown in the site layouts for the northbound and southbound lanes in Figures 5.4a and
5.4b, respectively.

Loop inductance measurements are conducting by connecting the multimeter (set to measure
inductance) to the two ends of the loop wire. If the loops are connected to a traffic count/classify
equipment, they are disconnected from the equipment prior to the measurements. The measured
inductance, in microHenries (uH), is recorded for each loop in the laboratory notebook.
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The ground resistance of each loop is measured by connecting the multimeter to one end of the
loop and to the earth ground located in the TTMS cabinet. The multimeter is set to measure
resistance, in MegOhms (MQ), and the ground resistance is recorded in the laboratory notebook.
Again, the loop must be disconnected from any traffic count/classify equipment for accurate
measurement of ground resistance. Note that the typical maximum range for a handheld
multimeter is 50 MQ; any ground resistance higher than 50 MQ is recorded as having “infinite”
resistance.

To measure the inductance, the multimeter knob is tuned to the appropriate range of the
inductance area and the two probes of the meter are connected to the loop sensor terminal pairs.
The value of the inductance is read off the screen and recorded in a laboratory notebook. Similar
procedure is repeated for the ground resistance measurements for all the loop sensors at both site
112 and 352.

A summary of the data collected for the inductance and ground resistance of the loop sensors at
sites 112 and 352 in the period of February to December 2009 is shown in Figures 5.5 and 5.6.
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5.2 Results and Analyses of Field Tests

Several field tests were made by the research team between April and December 2009. Peak
outputs from the piezoelectric sensors at Site 352 were recorded during the tests in June, July,
August and October. Loop inductance and ground resistance was recorded for each loop at Sites
112 and 352 in field tests conducted in February, April, June, July, August, October and
December. The data was collected on each visit was processed to identify any trends regarding
the degradation of the sensors performance.

Summary of Piezoelectric Sensors Results

To test the performance of the piezoelectric axle sensors at Site 352, the peak voltage output was
recorded to the front and rear tires of a test vehicle, a Chrysler Town & Country Minivan. For
each field test the test vehicle was driven at 60-70 MPH across the sensors a total of five times.
The average of the peak outputs for each axle of the vehicle on each piezo sensor was recorded.
A summary of the average peak outputs is shown in Figure 5.5. Piezo sensor 1, installed using
the G100 sealant, produced the least voltage output of all, giving a maximum output of 0.2 volts.
Piezo sensor 2, installed using the AS475 sealant, produced an overall average output range of
0.35 volts to 0.45 volts. Piezo sensors 3 and 4, installed with Fabick 1:1 and Fabick 2:1 sealants,
produced the largest average output range of 0.35 volts — 0.75 volts and 0.35 volts and 0.65 volts,
respectively. The data collected during these tests revealed no identifiable trends in the output
voltages of the piezo sensors. Any wear or degradation of the sealants used had no noticeable
effect on the outputs of the sensors. Variations in the average peak output voltages appeared to
be somewhat random and are more likely due to external influences such as the position of the
vehicle in the lane and possibly temperature.

For comparison, the peak piezoelectric peak outputs were recorded for random Class 9 vehicles
passing through the Site 352 during the field tests. Figure 5.6 charts the average peak piezo
outputs for the field tests in July, August and October. In December a computer failure
prevented the collection of piezoelectric output voltages. Given that there is no knowledge of the
weight of these Class 9 vehicles, there is no way to identify trends due to degradation of the
sensors or sealants. These measurements demonstrate the range of voltages produced by the
piezoelectric sensors for heavy vehicles.
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Comparison of Average Peak Outputs of the Piezo Sensors for Test Vehicle

Loon1-G100 - Loop1-G100 - Loop2-AS475 - Loop2-AS475 - Loop3-FAB1:1 Loop3-FAB1:1 Loopd-FAB2:1 Loopd-FAB2:1
FT RT FT RT -FT -RT -FT -RT
June 04 Field Test 0.1446 0.1504 0.3669 0.3751 0.5918 0.5635 0.6406 0.6333
July 08 Field Test 0.18704 0.18564 0.3923 0.36576 0.76092 0.712596 0.38014 0.3423
August 18 Field Test 0.214375 0.183325 0.463125 0.3976 0.43745 0.350375 0.493075 0.387775
October 20 Field Test 0.18446 0.15608 043324 0.35646 0.55402 0.4622 0.45302 0.3767

Figure 5.5: Average Piezoelectric Axle Sensor Peak Outputs for Field Tests Using the Test Vehicle.

m June 04 Field Test

M July 08 Field Test

W August 18 Field Test

M Cctober 20 Field Test

FT: Front Tire RT: Rear Tire
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Summary of the Ground Resistance and Inductance Measurements

Prior to the start of this task, contractors working for the FDOT recorded inductance and ground
resistance for the 12 inductive loop sensors at Site 112. It was noted that loops #8 and #11 had
ground resistances less than 50 MQ and that there appeared to be significant wear on the sealants
used at the site. A field test was conducted on February 18, 2009 to verify the measurements and
to perform a physical inspection of the site. During this field test, the inductance measurements
were consistent with the earlier measurements made by the contractor, however, all of the loop
ground resistance measurements were infinite (> 50 MQ). The apparent cause for the difference
appeared to be the weather during the tests. During the measurements conducted by the FDOT
contractor there was wet weather, but during the February field test the weather was dry.

On March 23, 2009, the FDOT had the Site 112 repaired in an attempt to extend the useful life of
this TTMS. Loop #11 was replaced; loops #1-4 and 12 were resealed. Various loop sealants
were used to assess the performance the durability of the sealants. On April 6, 2009 a field test
was conducted to measure the inductances and ground resistances of the loops after the site
repair. The loop inductances were consistent with previous measurements with the exception of
the loop that was replaced (loop #11) whose inductance increased by about 25%. All ground
resistances again measured infinite (weather was dry).

Beginning in June 2009, periodic (1 to 2-month) measurements of the inductance and ground
resistance of each of the loops at Site 112 and Site 352 were monitored in wet and dry
conditions. Figure 5.7 charts the loop inductances measured at Site 112. All inductance
measurements remained consistent throughout the tests with the exception of loop #11 which
was replaced (though that loop’s measurements were also consistent for all measurements after it
was replaced). Figure 5.8 contains a table of the ground resistances measured for the loops at
Site 112. Loop #11, which was replaced, consistently demonstrated infinite ground resistance.
However, loop #12 and several other loops, most noted by Dr. Moses’ team as having visible
damage to the sealants, were measured as having ground resistances < 50 MQ. The ground
resistance measurements show an apparent degradation over time of the ground resistances of
several loops. Also, it appears that ground resistance decreases significantly during wet weather.
Note that although some of the loops had ground resistances measured below 1 MQ, there were
no apparent effects on the loop inductance and the TTMS continued to produce consistent traffic
counts and classifications.

The loop inductances and ground resistances for the five loops at Site 352 are recorded in
Figures 5.9 and 5.10, respectively. Loop inductances remained consistent over the length of the
field tests for all the loops at the site. Loop #5 was the only loop that recorded a ground
resistance < 50 MQ at this site. This loop recorded ground resistances between 0.5 and 2.4 MQ
during each field test. This loop was noted by Dr. Moses’ research team as having an exposed
wire where the sealant had failed.

20



™~

i

134

[}

-

(=]
D
e

o
—

170

o

—

135

M~
™
e

o
on
e

o0

i

142

L0

-

00
el
=

[o]
—

143

cn
-

0
N
e

s]

—

142

=t

-

00
m
e

(=)}
|

141

(=]
-

(=)}
—

143

=

—

143
145

=r

A

5]
—

148

w
—

]

—

152

o

=

5]
—

149

r~
—

[Xa]

—

149

ield Test

Aug. 13 F

Oct. 20 Field Test

21

Aug. 13 Field Test mOct. 20 Field Test M Dec. 10 Field Test

Figure 5.7: Inductance Measurements of Loop Sensors at Site 112 on 1-75

W Before Feb 18 M Feb. 18 Field Test ™ April 06 Field test M June 04 field Test ™ July 08 Field Test




Comparison Table for Resistance Tests for Site 112

Loop | (Wt Day) | 021809 032509 | 040609 | iy | 0m0m2009 | Puo® T | wet Day)
(MQ): : : (MQ): : (MQ):
1 Infinite Infinite Rese:'sef?gsmg Infinite Infinite igg 5.8 8.31 0.41
2 Infinite Infinite Resf"sef7;‘5i”9 Infinite Infinite 0.298 - 1.5 5.35 4.81 0.36
3 Infinite Infinite Resealed using Infinite Infinite Infinite Infinite Infinite Infinite

Bondo

Resealed using
4 Infinite Infinite Bondo & shoulder Infinite Infinite Infinite Infinite Infinite 22.8
using Fabcik 2:1

5 Infinite Infinite Shoulder resealed Infinite Infinite Infinite Infinite Infinite Infinite
using Bondo

6 Infinite Infinite Shoulder resealed Infinite Infinite Infinite Infinite Infinite Infinite
using Fabick 2:1

7 Infinite Infinite Shqulder re;seal.ed Infinite Infinite Infinite Infinite Infinite 10.54
using Fabick 2:1

Shoulder resealed
8 46.4 Infinite using Bondo Infinite Infinite Infinite Infinite Infinite 16.6

Shoulder resealed

9 Infinite Infinite using AS475 Infinite Infinite Infinite Infinite Infinite Infinite
Shoulder resealed -483112?)
10 Infinite Infinite using AS475 Infinite . . 2.68 2.72 0.96 0.98
direction
gives infinite
Replaced using Infinite
11 12.5 Infinite 3M and topped by Infinite Infinite Infinite Infinite Infinite
G100
1st Reading:
- - Resealed using - 10-17
12 Infinite Infinite Fabick 2:1 Infinite 24 Reading: 21.4-24.6 5.13 13.55 8.5
11.6

Figure 5.8: Resistance Measurements of Loop Sensors at Site 112 on I-75




Comparison Chart for Inductance of Loop Sensors: Site 352
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June 04 Field Test 159 156 154 145 147
July 08 Field Test 159 156 155 146 147
August 13 Field Test 156 154 152 143 145
October 20 Field Test 156 153 153 144 145
December 10 Field Test 160 156 153 146 148

B June 04 Field Test

Figure 5.9: Inductance Measurements of Loop Sensors at Site 112 on 1-75
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Comparison Table for Ground Resistance Tests for Site 352

Loop Sealant | 06:04:2009 | 07:08:2009 08:04:2009 10:20:2009 12:(:\,?;22)909
used (MQ): (MQ): (MQ): (MQ): Wet Day
1 3M Infinite Infinite Infinite Infinite Infinite
2 3M Infinite Infinite Infinite Infinite Infinite
3 WABO Infinite Infinite Infinite Infinite Infinite
4 FAE_IfK 1.45 0.466 2.35 2.2 0.84
5 FAE’_I:LCK Infinite Infinite Infinite Infinite Infinite

Figure 5.10: Resistance Measurements of Loop Sensors at Site 112 on 1-75
Analysis and Recommendations

The research and testing conducted under this project has demonstrated that the sensors installed
to a large extent are in working condition. Through the testing and measurements conducted in
the tasks and the post data processing done, the behavior of the sensors have been accurately
monitored over time in determining whether or not the performance of the sensors are degrading.
The results have also been useful in assessing the performance of the grouts (i.e. 3M, WABO,
G100, AS 475, Fabick 1:1 and Fabick 2:1) used as sealants for the sensors. From piezoelectric
sensor voltage measurements made at Site 352, the Fabick 2:1 sealant used to seal piezo sensor 4
produced the largest voltage response during the test runs, while the G100 used to seal piezo
sensor 1 produced the smallest voltage response.

The loop inductance measurements made at Site 112 and Site 352 demonstrated that the
inductance remained relatively stable for loops with and without degradation (as seen in
dropping ground resistance measurements. Electrically, the loop inductance is not expected to
be measurably affected unless the loop wire is severed, loop wires in separate turns of the loop
short together, or the ground resistance of the loop gets very low (< 100 KQ). So this result is to
be expected.

The loop ground resistance measurements at Site 112 seemed to indicate that resealing a loop
can improve the ground resistance of the loop, but the improvement may not last as long as
replacing the loop (see loops # 8 and #11 in Figure 5.8). Also, weather conditions (wet or dry)
seemed to have a significant impact on ground resistance.

Continued periodic measurement of the inductive loops and piezoelectric sensors at Sites 112

and 352 is recommended. Also, continuous logging of loop ground resistance and weather (rain
and temperature) at Site 352 is also recommended to investigate the correlation between weather
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conditions and loop ground resistance changes. Under this project the weather equipment was
acquired for the continuous monitoring at Site 352. Using the Campbell Scientific CR800 data
loggers used for the lightning surge measurements, the air and pavement temperature, the rainfall
amounts, and the ground resistance of all 5 loops at Site 352 can be continuously recorded. This
effort will continue in future research to support the Transportation Statistics Office of the
FDOT.
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6. Conclusions

This project has included several efforts to support and improve the operation of the FDOT
Telemetered Traffic Monitoring Systems. The major areas of support included:

1. Lightning Surge Suppression Field Tests,

2. Segmented Sensor Interface Electronics Improvements,

3. Sensys System Support for Short-Term Traffic Count Applications, and
4. Monitoring Loop Ground Resistance and Piezoelectric Sensor Outputs.

The field testing of the lightning surges experienced by the TTMS in-pavement sensors is
providing the information necessary to identify the proper lightning surge protection for the
traffic monitoring equipment. These tests are demonstrating the need for surge suppressors able
to suppress lightning surges up to 3,000 amps and able to endure thousands of surges without
failure.

The research into the segmented sensor interface improvements has demonstrated that the high
resistance, intrinsic capacitance and structure of the extruded segmented sensor make a simple
conductance test inaccurate for identifying segment closures. The design of the interface is now
delayed pending funding through the FHWA.

The field testing and analysis of the Sensys wireless traffic monitoring system has shown that it
is feasible to use it for short-term traffic count applications. The access point (AP) can be set up
for a temporary traffic count site, and the setup can be stored for future use at that particular site.
This will allow a single access point to be moved efficiently between temporary traffic count
sites. The access point for this application must be an AP240 with the S designator to allow the
access point to store traffic statistics. An instruction manual for operating the Sensys system for
temporary traffic counts is provided in Appendix A.

Monitoring the electrical characteristics of loops and piezoelectric sensors at Sites 112 and 352 is
providing information on the results of the degradation of sealants and grouts used to install the
sensors. It is also demonstrating the differences in reliability and wear between resealed loops
and replaced loops. These measurements combined with analysis by a Civil Engineering
research team led by Dr. Ren Moses will help the FDOT identify the most effective maintenance
procedures to extend the operating life of the sensors in a TTMS installation. It will also help to
determine the most effective sealants to be used in the environment of the state of Florida.
Continued research is still needed to complete the analysis of the degradation of the sensors and
to identify the impacts of weather.

26



7. Benefits to the FDOT
The results of this project have provided four specific benefits to the FDOT.

a. The lightning field tests have led to the specification and recommendation of reliable
surge suppressors to protect the sensitive electronics in the TTMSs. This has improved
the reliability of the TTMSs and reduced the cost of repairs to the TTMS equipment due
to failures caused by lightning surges.

b. Improved classification of vehicles using the segmented axle sensor has been
demonstrated in field tests. Improving the interface electronics design for a more durable
extruded polymer sensor will provide the FDOT with a tool to significantly improve
vehicle classification and monitoring.

c. The Sensys wireless traffic monitoring system has been shown to be a good alternative to
pneumatic tube systems for temporary traffic count applications. Use of the Sensys
system will improve reliability of the sites and reduce costs using the permanent in-
pavement Sensys sensors rather than pneumatic tubes.

d. Research into the effects of in-pavement sensor sealant degradation on the electrical
properties of the sensors will help the FDOT reduce maintenance costs by identifying the
most durable sealants and the most effective maintenance procedures to extend the life of
the TTMS in-pavement sensors.
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Appendix A

Instruction Manual for Operating the Sensys System for Temporary Traffic Counts
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Instruction Manual for Operating
the Sensys System for
Temporary Traffic Counts
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Abbreviations:
AP: Access Point
FTP: File Transfer Protocol

RF: Radio Frequency

Notations:
Hyperlinks, or selectable buttons and tabs will be in bold italics (e.g. Hyperlink).
Labels on web pages or in software will be in italics (e.g. Labels).

Data to be entered into a field on a web page or in software will be in Lucida Console font
(e.9.192.168.2.99).
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1. Introduction

This Instruction Manual provides information and the procedures for using the Sensys System, which was
initially designed to operate in a server controlled network, for temporary traffic counts.

The instructions will allow the user to fully understand the Sensys Networks Vehicle Detection System,
properly configure the Sensys access point (AP) for the traffic count site, and retrieve the traffic count
data from the access point.

The instructions provided here are to accomplish the following tasks:

1.

Notes:

System Components and Requirements

Configuration of Field Laptop Computer

Configuration of the Sensors

Initial set up of Access Point

Backup and Restore of Access Point for multiple site application

Downloading Statistical Data & Exiting TrafficDOT Application

Some of the contents have been summarized from the Sensys Online Reference Manual. If more
clarification will be needed, view the Sensys Online Reference Manual at
www.sensysnetworks.com in the Dealer Login section or the Sensys Reference Guide in the
Technical Docs section..

These instructions are applicable to the Windows XP operating system.
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2. System Components and Requirements

The implementation of the Sensys system for temporary traffic counts requires the following components
for its basic operation:

>

Sensys Wireless Sensors

These are pavement mounted magnetometers equipped with wireless radio transmitters to detect
the presence and movement of vehicles.

Sensys Access Point

This is an intelligent device that establishes overall time synchronization of the system, transmits
configuration commands and message acknowledgements and receives and processes data from
the sensors. For the statistics —processing purpose of this project, the version of access point to be
used should be AP240 including the upgraded S version such as the AP240US or AP240ES. Any
other S-version could be used as well.

TrafficDOT Software

This is monitoring application software from Sensys network that provides graphical user
interface (GUI) to the components of Sensys Traffic count system. (Installation will be explained
in Section 2).

Laptop Computer with an Ethernet port.

The instructions on this manual are based on Windows XP Operating System. The Mac, Unix,
Linux or other Windows can also be used based on a different instruction set. Minimum
requirements are: 40GB HDD, 1.8GHz CPU, 1024MB Memory, and the Mozilla Firefox web
browser.

Ethernet Cable

Use a Cat 5 or a better Ethernet cable that is at least 1.5m long terminated with male RJ 45
connectors on both ends.
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3. Configuration of the Field Laptop Computer

The laptop computer used to communicate with the Sensys access point must meet the following
requirements:

1. Laptop must be configured to a fixed IP address.

2. Laptop must have TrafficDOT application software installed
3.1 Configuring the Laptop to a Fixed IP Address
The IP Address is found under Network Connections.

» On the laptop computer click on Start menu—> My Network Places and then click on the link
View Network Connections which is on the left side of My Network Places window.

"% Metwork Connections

Fle FEdit View Favorites Tools Advanced Help I3
1 ) @] = o
L€ P J L% >~ Search li' Folders
address | @) Network Connections v B
Dial-up
g ] @—'ﬂ 3G Connection
[l Create 2 new connection o] Disconnected, Firewalled
9 Setup a home or small \;L Conexant HDA D330 MDC V.9...

office netwark

@ Change Windows Firewall
settings

@5 1394 Connection @'ﬂ Wireless Network Connection
Connected, Firewalled | Connected, Frrewalled
See Also T oA, 1394 Net Adapter T G Dell Wireless 1395 WLAM Mini-...

i) Network Troubleshoote
N Tetwork Troublesnogter @Tﬁ Local Area Connection 2 @ﬁ'ﬂ Mebile Broadband Cannection

Connected, Firewalled Network cable unplugged, Fire...
T &, Sroadcom Nettreme 57xx Gig... & Del Wireless 5720 VZW Mobile...

LAN or High-Speed Internet

Other Places
2 Local Area Connection 4
G» Control Panel ] Disabled, Firewalled

&3 My Network Places T A, Cisco Systems VPN Adapter
[} My Documents

My Computer

Details

letwork Connections
System Folder

Figure 3.1: Network Connection Window

» Right click on the desired Local Area Connection (LAN) and select Properties (see Figure 3.1).
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>

>

>

-+ Local Area Connection 2 Properties |E|r5__(|

General | Advanced |

Connect using:
| B8 Broadcom Mettreme 57 Gigabit C ‘

Thig connection uges the following items:

B Deteministic Netwerk Erhancer ad
gFile and Printer Sharing for Microsoft Networks
QQUS Packet Scheduler -
¥~ Intemet Protocal (TCP/1P) ¥
< | &
[ Install... ] [ Uninstall ] [ Properties ]

Diescription

Allows your computer to access resources on a Microsoft
network.

[[] Show icon in notification area when connected
MNotify me when this connection has limited or no connectivity

[ 0K ][ Cancel ]

Figure 3.2: Local Area Connection Properties Window

Double Click on Internet Protocol (TCP/IP) (see Figure 3.2).

nternet Protocol (TCP/IP) Properties ?X

(General | Atemate Corfiguration |

If this computer is used on mare than one network, enter the atemate IP
settings below.

() Automatic private |P address
(® User corfigured

IP address:

Subnet mask:

Prefemed WINS server: I:l
Atemate WINS server: I:l

[ oK ][ Cancel ]

Figure 3.3: Internet Protocol Properties Window

If the Alternate Configuration (see Figure 3.3) tab is available, select User Configured, and fill
out the IP Address and the Subnet mask as shown. Click Ok.

This will enable you to connect up at any time without needing to reconfigure the IP port in the
future.

If the Alternate Configuration is not available, then you will need to change the IP address as
shown Figure 3.4. Note the original settings prior to making any changes.



f

General

You can get IP settings assigned automatically f your network supports
this capability. Otherwise, you need to ask your network administrator for
the appropriate IP settings.

(O Obtain an IP address automatically
(&) Use the following P address:

—
o
]
o
=]
%]
o
w0

IP address:

(]
£
n
]
£n
n
]
&

Subnet mask:

Default gateway:

(®) Use the following DNS server addresses:
Prefemed DNS server:

Altemate DNS server:

[ OK ][ Cancel ]

Figure 3.4: Internet Protocol Properties/General Window

You will need to perform this step (and reverse it back after completing use of TrafficDOT) every time

you use the laptop with the system.

3.2 Installation Procedure for TrafficDOT Application Software

» Put the TrafficDOT software media (CD) for windows version in the CD drive of the laptop.

Note: The Software can also be downloaded from the Dealer’s page on Sensys website.

&) TrafficDOT-1.8.4-7 : 06/30/09

License Agreement

Please review the license terms before installing
TrafficDOT-1.8.4-7,

Press Page Down ko see the rest of the agreement.,

COPYRIGHT (C) 2006, 2007, SENSYS NETWORKS, INC, ALL RIGHTS s
RESERMED

CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE LISING

THE PROGRAMS, USE OF THE PROGRAMS INDICATES Y¥OUR

ACKMOWLEDGEMENT THAT ¥OU HAYE READ THIS LICEMSE, UNDERSTAMD IT,

ArD AGREE T BE BOURD BY  ITS TERMS AND CONDITIONS, IF ¥OU DO

MOT AGREE TO THESE TERMS AMD COMDITIONS, PROMPTLY RETURMN THE

PROGRAMS AND USER MANUALS TO THE PLACE OF PURCHASE AND Y OLUR

FPURCHASE PRICE WILL BE REFURDED, ¥OU AGREE THAT YOUR USE OF

THE PROGRAM ACKHMOWLEDGES THAT YOU HAVE READ THIS LICENSE, w

If wou accept the berms of the agreement, click I Agree to conkinue. You must accepk the
agreement ko install TrafficDoT-1.8.4-7,

[ I Agree ] [ Cancel

Figure 3.5: Installation License Agreement
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» Continue by clicking on the I Agree button (see Figure 3.5).

» Install all components of TrafficDOT by checking all the boxes in the Choose Components screen
(see Figure 3.6).

& TrafficDOT-1.8.4-7 : 06/30/09

Choose Components
Choose which features of TrafficDOT-1.5.4-7 vou want to install,

Check the components wou wank toinstall and uncheck the components vou don't wankt to
install, Click Mext ko continue.

Select components to install: TrafficDOT 1.6.4-7 Description
Start Menu Shorkcuts
Deskkop Menu Sharkcuks
Install Java Runtime 1.6
Space required: 22.3ME
< | s
[ < Back, ” Mext = l [ Cancel

Figure 3.6: Choose Installable Components Windows

> Click the Next button.

» If desired, change the Destination Folder for the software on the Choose Install Location window
(see Figure 3.7).

A-10



B TrafficDOT-1.8.4-7 : 06/30/09

Chooze Install Location
Choose the Folder in which to install TrafficDOT-1.8.4-7.

Browse and select another Folder, Click Install bo start the installation,

Destination Folder

_:\Program FilesiSensys Metworks) TrafficDioT-1.8.4-7) | Erowse, ..

Sparce required: 22.3ME
Space available: 201.5G8

Setup will install TrafficDoT-1,8.4-7 in the Following Folder, To install in a different Folder, click

[ <= Back ” Install ] [ Cancel

Figure 3.7: Choose Install Location Window

» Click the Install button to begin the installation.

» The progress of the installation will be reported on the Installing window (see Figure 3.8).

® TrafficDOT-1.8.4-7 : 06/30/09 M=

Installing
Please wait while TrafficD0T-1.8.4-7 is being installed.

Execute: "Ci\Program Files!3ensys Metworks) TrafficDoT-1.8.4-Ajre-ous-windows-i556-p, exe

ARNAARNAARRR RN AR N RR N RN AR RN A RN AR RN AANNd |

Extract: mail. jar... 100%

Extract: spring.jar... 100%

Cutput Folder: Ci\Program Files!Sensys Mebworks! TrafficDOT-1.8.4-7\libexec

Cutput Folder: C:\Program Filest3ensys Metworks) TrafficDioT-1.5.4-7

Extract: ican.ica... 100%

Created uninstaller: C:\Program Files!Sensys Mebworks)\ TrafficDOT-1.8,4-7uninstall. . ..

Create shorkcut: CiDocuments and SettingstijlesikalDeskiop) TrafficDOT-1.8.4-7 .0k

Create Folder; Ci\Documents and SettingsijlesikalStart Menu\ProgramstSensys Mebw, ..
Create shorkcut: CiDocuments and SettingstjlesikalStart Menu\Programs|Sensys Ne. ..
Create shorkcub: CiDocuments and SettingstijlesikalSkark Menu)Programs|Sensys MNe. ..
Create shorkcut: CiDocuments and SettingstjlesikalStart MenulPrograms|Sensys Ne. ..

Execuke: "CiiProgram Files!Sensys Metworks TrafficDOT-1.8,4- 7\ jre-6ud-windows-is, ..

-

Figure 3.8: Installation Status Window
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Note: If the Java Runtime Environment is required, a separate installation process occurs.
Accept the Terms and Conditions to continue. Wait for the installation to complete. Click on
the Finish button.

» The results of the installation will appear on the installation window (see Figure 3.9).

® TrafficDOT-1.8.4-7 : 06/30/09 El=3

Installation Complete
Setup was completed successFully,

Completed

Extract: spring.jar... 100% A
Cutput Folder: :Program FilestSensys Metbworks! TrafficD0T-1,8,4-7ibexec

Cutput Folder: :Program FilestSensys Metworks! TrafficDQT-1,8,4-7

Extract: icon.ica, ., 100%

Created uninstaller: :iProgram FilesiSensys Networks) TrafficDOT-1.8.4-Fluninstall. ..
|Create folder: C:\Documents and Settingstjlesikalstart MenuiPrograms!Sensys Networks'l,TraFﬁcD
Create shorbeut: CDocuments and Settings|jlesikalatart MenulPrograms\Sensys he...
Create shorbeut: CiDocuments and Settingstjlesikalatart MenulProgramsiSensys he...
Create shorbeut: CiDocuments and Settingstjlesikalatart MenulProgramsiSensys he...
Create shorbeut: CiDocuments and SettingstjlesikalDeskiopt TrafficDoT-1.8.4-7.Ink
Execute: "C:\Program Files',Sensys Metworks) TrafficDoT-1,8,4-7jre-6us-windows-is. .
Completed

Close

Figure 3.9: Installation Completion Window

» Complete the TrafficDOT software setup wizard by clicking on the Close button.
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4. Configuring the Sensors Using the TrafficDOT Application Software

Sensors ship with a factory default configuration for count applications. In most cases, the configuration
is modified to fit the specific needs of an installation. However, once set, a sensor's configuration
typically requires no further changes.
Sensor configuration involves selecting values for the following parameters:

» Operating mode

» Radio Frequency Channel

From the main TrafficDOT window, select the Configure menu and click Sensors (see Figure 4.1).

Connect Cnnﬁgure| Control Tools

cansor Access Point .. F
011E Sensors.. 62 (

0Csg
0SDF Repeal ConfigLre SEFIS_UFS
01248 Controller Cards ... -81 {

Figure 4.1: Configure Sensors Window

The Sensor Configuration window appears (see Figure 4.2).

@ =55 Conhguration dda‘
r Configure Sensor

| Refresh Available List |

[ Jr

Available Selected
OB5SF
O0BDA
|Shcw all slats, including in used ones|
L] Time Siot: [§_[~| ]

0B13 03A3
0B7T9
0 o :
[] RF Chamnel: |Z|Z| \
[[] Recalibration:

| Apply all checkad parameters |

| BinkLED || Reset(keenRF) || HardReset |

| Download Firmware |

Figure 4.2: Sensor Configuration Window

Click Refresh Available List button and all the available sensors will be displayed.
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4.1 Selecting Sensors to Configure

Sensors are selected by moving their IDs from the Available list to the Selected list as follows:

From the Available list, click one or more sensor IDs. (Note: On Windows platforms hold down the
SHIFT key while clicking to select multiple entries in series.)

» Click the button labeled Add >>. The sensor ID(s) appear in the Selected list.
To remove IDs from the Selected list, do the following:
> From the Selected list, click one or more sensor IDs.

» Click << Remove. The sensor IDs are removed from the Selected list and appear in the Available
list.

4.2 Setting a Sensor's Operating Mode

The sensor's operating mode defines the type of detection data it transmits. To set the operating mode, do
the following after selecting the sensors to be configured:

» Fill the check box to the left of the label Mode by clicking it.
(The entries on the Mode drop-down list are the operating modes available for sensors.)

» Select an entry from the list by clicking it.
(Select Count (B), for the statistical count application).

4.3 Setting a Sensor's RF Channel

All sensors associated with an Access Point must use the same frequency as the Access Point. To set the
RF channel, do the following:

» Fill the check-box to the left of the label RF Channel by clicking it.

» The entries in the RF Channel drop-down list correspond to the 16 frequencies available for use.
Select an entry from the list by clicking it. Note: The factory default channel is zero.

» Click Apply all checked parameters.

4.4 Managing Sensor Tables and Lane Names

Access Points store information describing sensor locations and relative positions in two databases. The
databases are:

» Sensor Table — also referred to as the “dots” configuration table. This database stores an entry for
each sensor in the network including its lane position.

» Sensor-Pair Table — also referred to as the “dot pairs” configuration table. This database includes

one entry for each sensor-to-sensor relationship forming a speed pair (pair of sensors used to
measure vehicle speed).
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4.4.1 Adding a Dot (Sensor Table) Configuration Entry

To add a new entry, do the following:

From the Configure menu, navigate to Sensors and then click on the Dot Table in order to display the
table (see Figure 4.3).

>

Position the cursor in the Dotld16 column on a blank row. Type the 4-character HEX Id
(hexadecimal identification number) of the sensor.

If the sensor is used with a traffic controller, supply the card address in the column Address 170.
If the sensor is not used with a signal controller, type a zero into the field.

Type into the Lane field a short text description of the lane in which the sensor resides.

Type into the Position field an integer between 0 and 2 that indicates the sensor's relative position
in the lane.

Note: Positions are determined by counting up from zero in the direction of the traffic's travel.
That is, a vehicle will first drive over sensor zero, then sensor one and then sensor two. There is a
maximum of three sensors per lane. The sensor in position zero must be defined before the sensor
in position one, and position one must be defined before position two.

The check box at the left edge of the row designates the sensor as being included (or ignored) by
statistical or other applications. The check box is filled by default which indicates the sensor will
be included hence do not uncheck.)

Click Apply from the Operations menu to add the entry.
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-ulf'i‘gjh'r_e-z.s: Sensor Table (Dots Configuration table)

4.4.2 Adding a DotPairs (Sensor-Pair Table) Configuration Entry

The data contained in this table gives value added information from the detection events. For instance,

speed,

length gap and other values can be derived only by knowing the relative position and distance

between two sensors. To add a new entry, do the following:

>

>

From the Configure menu, navigate to Sensors and then Dot Pair Table (see Figure 4.4).
Fill the check-box to the left of the DotPairs Configuration table.

Position the cursor in the Leading Dot Id column on a blank row. Type the 4-character HEX Id of
a sensor.

Note: A leading sensor is the sensor that a vehicle first passes over when traveling in the direction
of normal traffic flow.

Type into the Trailing Dot Id field the 4-character HEX Id of a sensor.

Note: A trailing sensor is the sensor that a vehicle passes over second when traveling in the
direction of normal traffic flow.

Type into the Separation field a decimal value (in millimeters) specifying the physical distance
between the leading and trailing sensors.
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Operations

Figure 4.4 - DotPairs Configuration Window

» Click Apply from the Operations menu to add the entry.

Leading Dot Id Trailing Dot Id Separation
naGc2 naG3 GO96]| =~
L] 06C3 O6CH G056
0656 O67F G056
L] Q67F Qgc G026
D4A4 0437 6096| =
L] 0457 0653 6056
0494 04A0 6020
L] 0440 d4a1 G045
0452 0458 6045
L] D456 04354 6020
0401 0404 5954
L] 0404 0446 6020
QaD7 Qgcy G026
L] J6Ca a6ca G045
06E0 0650 6071
L] 0650 0643 6071
0671 0670 G056
L] 0670 OGEF 6056
JEBS OGBAC G056
L] O6AC 0672 G056
0756 0204 6071
| Successfully retrieved 23 rows from AP
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5. Initial Set up of the Access Point

The Access Point has to be correctly configured so as to be able to perform the statistics count
application.

5.1. Connecting the Laptop to the Access Box

Before you can set up/configure an Access Point, a connection between the laptop computer and the
access point (AP) must be established.

» Turn on the laptop.

» Plug one end of the Ethernet cable to the Ethernet -port of the laptop and the other end to the
Ethernet port of Access Box (See Figure 5.1).

Sensys Access Point

;

N

Laptop or PC

Sensys AccessBox

All connections are made with
CATS (or better) straight-through
Ethernet cables

Figure 5.1: Connecting an IP Device (Laptop) to a Sensys Access Box

5.2. Connecting to the Access Point via TrafficDOT Appricauur
» Double-click on the TrafficDOT icon on the desktop (shortcut).

» Type the access point’s IP Address and TCP Port (See Figure 5.2).
Default IP address: 192.168.2.100
Default TCP port: 20000

Note: It is recommended to use the default IP address and port number.
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IP Address [192.168.2.100 |
TCP Port [ 10000 |

| Connect || Discowver |

|
Figure 5.2: TrafficDOT Application Connection Window

> Click the Connect button.

Note: If the IP address of the access point is not known, click on Discover button. The Discover
button queries the local network and opens a window that lists All the Access points on the
network. Make a note of the IP address of the access point you wish to connect to. Click on
Dismiss button to close the window and return to connect window.

5.3 Configuring the Access Point

» To configure an Access Point, access the Configure menu and click Access Point (See Figure
5.3).

Connect Cunﬁgure| Conmtrol Tools

Sensor Access Point ... [ F
Se Configure Access Point|

Repeaters ...

Controller Cards ...

Figure 5.3: Configure Access Point Menu

The Access Point Configuration window appears with the current configuration data loaded into
its tabular display (See Figure 5.4).
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@ HCCESS FOInNt Saniguration dl ]Iﬂ

Operations

[[Radio | Event | Detection | Information

RF Channel 6 -

Radio Id

LNA Gain

PA Max. Power

PA Attenuation 0 dB -

| Successtully retrieved configurations from AP

Figure 5.4: Access Point Configuration Window

5.3.1 Setting the RF Channel
To set the RF channel, do the following:
» The entries in the RF Channel drop-down list correspond to the 16 frequencies available for use.
Select an entry from the list by clicking it. Note that the factory default channel is zero. The value
set on this section should correspond to the value set on the sensors’ configuration in Section 3.
» Click Apply from the Operations menu to apply the change or continue configuring the Access

Point.

5.3.2 Setting User ID and Password for FTP Services Hosted by the Access Point

Access points contain a local ftp server to provide a means of file transfer and disk access to authorized
users. The Access Point tab collects the user identifier and password string for the ftp user.

» From the Configure menu, click Preference (See Figure 5.5).
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Confgure | Comtrol 1)

Access Poink ...
Sensors ...
Repeaters ...

Conlroller Cands ...

Dot Tahle ...
Dot Fair 1able ..

Preference ...
— N

Figure 5.5: TrafficDOT Configure / Preference Menu

» Click on the Access Point tab (See Figure 5.6).

:@ Preference) d d E‘

Operations
Preference | Access Point |
Ftp User Id |r|:|0t |
Ftp User Password ocee |

Figure 5.6: User ID and Password
» Set the desired User ID and Password.
» Go to Operations then click Save.

5.3.3 Setting Up the Configuration for Bin Data Collection

After all the connections and set ups for the sensors have been completed, the configurations for bin data
collection can then be performed. From the main window of TrafficDOT go to the System ->
Configuration menu and perform the following:
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» Go to the Push tab (see Figure 5.7).
Push refers to movement of processed sensor statistical data from one host to another initiated by
an access point.

» Enter the 1st Destination IP. Enter the fixed IP address of the laptop as configured in Section 3
“Configuration of the Field Laptop Computer.” The IP address used was 192.168.2_99.

» Specify the Destination Port (required) (typically 10250 however any other port above 10000
can be used).

@) System Configuration

Operations

Caltrans D4 Poll | Marksman Poll | Advanced | Others |

Network VPN [ Push | Pon | Caltrans D3 Poll |
1st Destination Server (required) [192.168.2.99 [ =]
Destination Port (required) 10250 | ||
Buffer Reports
Stay Connected
Use Acknowledged Message Passing

1st Acknowledgement Timeout (s) | |

2nil Destination Server | |

Destination Port |

Buffer Reports
Stay Connected
Use Acknowledged Message Passing

2nd Acknowledgement Timeout (5) | |

Units |Imperi:al |v| L
Indmadual Car Reports |Disahle:l | - |
Report Interval |15 minutes | - |
Maximum File Size 100000 |
Average Speed L] -

Figure 5.7: System Configuration Window
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Verify that the following options are checked:
o Buffer Reports
e Stay Connected
e Use Acknowledged Message Passing

The following entries should be left blank:
e 1% Acknowledgement Timeout (s)
e 2" Destination Server
e Destination Port
e 2" Acknowledgement Timeout (s)

Uncheck Average Speed.

Set the Units to Imperial.

Verify that the Individual Car Reports entry is set to Disabled.
Set the Report Interval for bin collection to 15 minutes.

Set the Maximum file size to 300kB by entering 300000.
Note: Maximum file can be set up to 500kB. File size is determined by the number of lanes and
the length of time to be recorded.

While still on the System Configuration window, click on the Poll Tab (see Figure 5.8).

Set the TCP Port (required) to 1050.

Set the Operating Mode as Connection-based Polls using the dropdown menu.

Set the Units to Imperial

Set the Report Interval to 15 minutes.

Set the Individual Car Reports, the Speed Histogram, and the Length Histogram to Disable.
Set the Timestamp Option to End of Interval.

Set the Maximum file size to 300kB by entering 300000.
Note: Maximum file can be set up to 500kB. File size is determined by the number of lanes and
the length of time to be recorded.

Verify that the following are unchecked:
e Average Speed

e Use Diagnostic to correct Averages
o Display Diagnostics
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@ System Configuration

Operations
Caltrans D4 Poll Marksman Poll |/ Advanced |/ Others |
Network VPN | Push [ Pol | Caltrans D3 Poll
MNote: Valid AP-E License required
Sensys Poll Server:
TCP Port (required) 10250
Operating Mode Connection-based Polls -
Units Imperial -
Indmadual Car Reports Disabled -
Report Interval 15 minutes -
Maximum File Size |1 0o0on
Average Speed Ll
Speed Histogram Disahle -
Length Histogram Disahle -
Timestamp Option End of Interval -
Use Diagnostic to Correct Averages L
Display Diagnostics L]

Figure 5.8: System Configuration Window
5.3.4 Setting the Date via TrafficDOT
Click on the Others tab (see Figure 5.9) and do the following:
» Specify Free running in the Time Synchronization drop down menu.

> Set the correct time zone.
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» Set Serial Mode to RS485.
Note: RS485 sets the port for communications with traffic signal control equipment via a contact
closure card from Sensys Networks. This setting is mandatory for using the access point with
signal controllers.

@ System Configuration : E| [zl

Operations

Caltrans D4 Poll Marksman Poll rntwan{:ed |/ Others |

Network VPN | Push [ Poll | Caltrans D3 Poll
Master 170 Enable
Master 170 Logging Lewvel O -

Mote: Valid AP-E License required to run EventProxy

BEvent Port (required) |

Adaptive Holdowver O -
Time Synchronization Free Running -
Time Zone (recquired) ESTSEDT -
Serial Mode R5485 -

Figure 5.9: System Configuration Window->Others
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5.3.5 Saving the Configurations

» Click on Operations.

> Click on Save.

»  Click on Dismiss when finished saving (see Figure 5.10).

@

X

Updated Access Point Configuration;
Reboot to Activate New Configuration.

Dismiss

Figure 5.10: Successfully Saved Configuration Window

5.3.6 Rebooting the Access Point.

After all the configurations have been made to the access point, it has to be rebooted so as the changes to
take effect. This is very important and it is done via TrafficDOT’s Control menu (see Figure 5.11).

» Click on Control from main window and then select Reboot.

@ 192.168.2.100:10000 FEX

Connect Configure | Control | Tools System Log Help

Sensor D[ vers| Bun y ldle  |#Detections| RSS! Lal FER | Present Mode Slot Repeater | Channel Adv Settings
(9| BEDD 53: 7 3] 287| -B6 a5 -- B 18 Direct 10 ZEBX
9|  BABY 53. e 1 268 -82 94 - A B 42 Direct 10 78X
9| BE25 5333 3.63V 2 229 -76 95 - B g Direct 10 78X
~, SC4F 53.33 3.63V 7 311| -66 95 B 38 Direct 10 ZEBX

Figure 5.11: System Control Window
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5.3.7 Setting Date and Time via Telnet
» Reconnect the access point via TrafficDOT Application.
» Click on windows Start button and then click Run.

» Type telnet 192_.168.2.100 into the Open dialog box (see Figure 5.12) and then click
OK. This should open a new DOS window with prompt to log in (see Figure 5.13).

Run ?X
= Type the name of a program, folder, document, or

Cpen: elnet 192.168.2. 100 w

[ Ok H Cancel H Browse. ..

Figure 5.12: Performing a Telnet Connection in the Run Window

login

2% Telnet 192.168.2.100 _|o ﬂ
T =

Figure 5.13: Telnet Login Window 1
» Type the username (default login username is root) and then press ENTER on the keyboard.

» Type the correct password (see Figure 5.14).
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login: root
Pazsword:

& Telnet 192.168.2.100 = ﬂ
B

Figure 5.14: Telnet Login Window 2

» To set the date and time type “date-s YYYY.MM.DD-HH.MM” substituting YYYY, MM,
DD, HH and MM with the correct year, month, day, hour (24 hour clock) and minute,
respectively. The time entered should be in Greenwich Mean Time (GMT). For example, to
set the date and time to October 13, 2009 at 3:15PM EDT (Eastern Daylight Savings Time),
type date—s 2009.10.13-19:15 at the prompt (see Figure 5.15).

To adjust eastern time zone to GMT use the following:

1. For EST, add 5 hours (1 PM EST is 18:00)
2. For EDT, add 4 hours (1 PM EDT is 17:00)

2% Telnet 192.168.2.100 _|o ﬂ
B

login: root

Password:

it date —= 2087.18.13-18:15
Tue Oct 13 18:15:880 UTC 2889

Figure 5.15: Telnet Window for Date and Time Set Up
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6. Backing Up and Restoring the Access Point for Multiple Sites

This section is very important as it will enable the user to be able to store (back-up) a site configuration to
use the access point at another site. When returning to the original site, the user can restore the
configuration of the original site without having to repeat the lengthy setup. This can be extended to
storing the configurations for multiple temporary traffic count sites by using a haming convention that
allows the user to identify the back-up files from each traffic count site.

6.1 Backup of the Access Point Configuration

Backup activities are initiated from the System menu. Once the settings for a certain location have been
backed up, they can be retrieved next time when collecting data from that particular backed up site. Note:

Always perform back up for every first time site visit. To backup the current access point configuration,
do the following:

» Go to the TrafficDOT main window and select System -> Backup (see Figure 6.1).

© 192.168.2.100:10000

Connect Configure Control Tools gvslem| Log Help

Sensor D | Version | Battery | | Configuration ... PER | Present Mode Slo# | Repeater | Channel | Adv Settings
@| 8E2s | 5333 | 3eav Backup .. = B g Direct 10 Zex
9| SCAF | 5333 | asav = B EE Direct 10 78X
@9 SEDD | 5333 | 3.67V Restore ... B 18 Direct 10 78X
9| @ABO | 5333 | &7V Save Diag B 42 Direct 10 78X

Update Firmware ...

License ...

List processes running on AP
AP command line interface

| piscover:on | Channel: 10 Devices:4 01:57:35

Figure 6.1: TrafficDOT’s System Menu

The Backup VDS240 window will appear (see Figure 6.2).

» Name the file by typing the site name on the File Name text box. A good choice of file name
should identify the data collection site such as AP_site_3041. Optionally, store the file to
a different folder than the default.

» Click Save to backup the access point configuration to the file.
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X

@) Backup VDS240

Select a local tar file to save the current Access Point Configuration.
Save in: | =192.168.2.100.10000 =]
D appalachee_sitetar
[y test.tar
File Name: [site_3041 |
Files of Type: |tar files | - |
| Save | | Cancel |

Figure 6.2: Back-up VDS window

» Wait for back up to complete and click Dismiss (see Figure 6.3).

@

Backup Completed.

Dismiss

Figure 6.3: Back-up Completion Window

Note: The same procedure will be followed when backing up the configurations for all other temporary
traffic count sites. Using unique filenames including the site number will simplify identifying the correct
file to restore when the access point is again used at each site.
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6.2 Restoring the Configurations

The restore function in TrafficDOT can be used to quickly restore an access point to a site configuration
that has been saved using the backup function. To restore a previously saved site configuration, connect
to the access point using TrafficDOT and perform the following steps:

» Click Restore from the System menu. The Restore VDS240 window appears (see Figure 6.4).
(®) Restora VD540, X|

Select a tar file to restore the Access Point configuration. Reboot is required
after the Restore operation.

Look In: |7 192.168.2.92.10000 v

File Name: ||

Files of Type: [tar files -

Open Cancel

Figure 6.4: Restore VDS240 Window

» Select the file that contains the backup that will serve as the source for the restore. Optionally,
navigate to a different folder than the default.

» Click Open to restore the Access Point from the file.

» Reboot the access point by clicking on Control from main window and then selecting Reboot.
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7. Downloading Statistical Data and Exiting TrafficDOT

The Statistical data collected by the access point can be downloaded for the analysis via the web browser
using ftp connection between the laptop computer and the Access point.

7.1 Downloading Data

» Go to your Web browser (Recommended: Mozilla Firefox web browser).

Note: Microsoft Internet explorer could also be used. Prior to using the Microsoft Internet
Explorer for downloading the data, perform the following:

e Open Internet Explorer. Select Tools > Internet Options from the menu bar (see Figure
7.1).

; TACKtech Corp. - Microsoft Internet Explorer

| Fle Edt Wiew Favoites | Toos Help

" b ail and Mews L3 I .
Back - = X Ihtto: ~  Favorites
J O o \—LI "' Synchranize... ey

N | ddress [&] http:/ A tacktech  Windows Update -]

E Internet Options... \ - I
: W =l
ﬁ Enables pou to change settings. o

Figure 7.1: Internet Options

o Click on the Advanced tab. Uncheck the Enable folder view for FTP sites option. Click
the OK button (see Figure 7.2).

e Close Internet Explorer.

e Re-open Internet Explorer to apply the changes.
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internetoptions g

Generall Securit_l..ll F'rivac_l..ll I:Dntentl Cnnnectinnal Progrars .ﬂ.dvanced[lk

Settings:

Browsing ;I
Always zend URLs az UTF-2 [requires restart]
Automatically check for Internet Explorer updates
Cloze unuzed folders in Higtory and Faworites [requires restart]
[ Dizable script debugging
[ Dizplaw a natification about ewvery script errar
Enakble folder wiewve for FTF sites
E&nable Inztall On Demand [Intermet Explorer]
F nable Inztall On Demand [Other]
Enable offline items to be sprchronized on a scheduls
Enable page transitions
[ Enable Personalized Favorites kenu
E nable third-party browser extenszions [requires restart)
[] Force offscreen compositing even under Terminal Server [requi
M atify when downloads complete

[0 Reuse windows far launching shortouts _|;|
4 | >

Bestore Defaults I

OF. ;l. Cancel | )] [ |

La
Figure 7.2: Enable folder view for FTP Sites option.

EOMETAMSTADS

On the web browser address bar, type “ftp://<username>@<ip address>" substituting
<username> with the username configured for the access point and <ip address> with the
configured IP address of the access point. For example, if the default IP address and username
were configured in the access point then type “ftp://root@192.168.2.100” into the address bar.

A pop up window asking for password should appear (see Figure 7.3).

Password Required g]

6 Enter password for root on ftp: /192, 163. 2, 100

[ 0K l [ Cancel

Figure 7.3: Password Request Pop up Window
Type the correct password and click OK. A list of folders will be displayed (see Figure 7.4).

Navigate to var/apstat_poll_tcp. A list of files will be available labeled using date format, double
click a file to open.

Select all the text in the file by pressing Ctrl+A on the keyboard, and then copy the text by
pressing Ctrl+C on the keyboard.
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3 Index of ftp://root@192.168.2.100/ - Mozilla Firefox
File Edit Wew History Bookmarks Tools Help

@ g C {a} ' B | fip:/f122.168.2. 100/ -] |G- P

&) Most Visited I Blackboard | ] Customize Links B ECE Overrides | ] F5UeSUSSAI ] FSU fyi ] FSUIEP Assessment [ | News I3 OMNI [ ) OurFAMU [ | Radio Links [ Weather

Index of ftp://root@192.168.2.100/

o Up to higher level directory

Name Size Last Modified
I bin 12/13/2008  12:00:00 AM
| boot 12/13/2008  12:00:00 AM
I dev 12/13/2008  12:00:00 AM
] etc 12/13/2008  12:00:00 AM
| home 12/13/2008  12:00:00 AM
1 lib 12/13/2008  12:00:00 AM
| mnt 12/13/2008  12:00:00 AM
| proc 11/30/198%  12:00:00 AM
shin 12/13/2008  12:00:00 AM
o 12/13/2008  12:00:00 AM
= usr 12/13/2008  12:00:00 AM
var 11301989 12:00:00 AM

Dane

Figure 7.4: Available Folders List Window
» Open a new file using notepad or Microsoft Word
» Paste the text into the file by pressing Ctrl+V on the keyboard.

> Save the file and close it.

Note: The files should be saved one after the other according to the dates they were created.
7.2 Exiting TraffficDOT

To end TrafficDOT session, do the following:

> From the Connect menu on the TrafficDOT main window, click Disconnect.
> Then click Exit.

Alternatively, you can close TrafficDOT by clicking the close window control in the upper right-hand
corner of the Access Point Control Center window.
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